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HMC System support

� The new HMC Version 2.11.1 will 
support the systems/SE (Support 
Element) versions shown in the 
table.

� The 2.11.1 HMC will support up to 
two 10/100/1000 Mb Ethernet 
LANs (1 Gb LAN support)

► Optional HMC External Switch 
available as 1 Gb

► Internal z196 switch for HMC to 
SE LAN connection has 1 Gb
ports

2.11.1932818z114

2.11.1,

2.11.0

86,

93

2817z196

2.10.2792098z10 BC

1.6.2269672/96749672 G5

1.6.2269672/96749672 G6

1.7.33G2064z900

1.7.33G2066z800

1.8.2552084z990

1.8.2552086z890

2.9.2672094z9 EC

2.9.2672096z9 BC

2.10.2792097z10 EC

SE 
Version

Firmware 
Driver

Machine 
Type

Machine 
Family



IBM Systems
SHARE Session 9686Page 6

IBM System z Hardware Management Console (HMC) 2.11.0 

© 2011 IBM Corporation

HMC/SE Secure FTP support – 2.11.1

� New support was added to allow a secure FTP connection from a HMC/SE FTP client to a 
customer FTP server location
► Implemented using the SSH File Transfer Protocol which is an extension of the Secure Shell 

protocol (SSH) 

► A new Manage SSH Keys console action allows the customer import public keys associated with a 
host address – added to both HMC and SE.

► Secure FTP infrastructure allows HMC/SE applications to query if a public key is associated with a 
host address as well as to utilize the Secure FTP interface with the appropriate public key for a given 
host. 

► Tasks utilizing FTP now provide a selection for the Secure Host connection. 

● When selected they verify that a public key is associated with the specified host name, and if 
none is provided they put up a message box to point them to the Manage SSH Keys task to input 
one. Tasks that provide this support include:
– Input/Output (I/O) Configuration -> Import/Export Source File ->FTP Location
– Customize Scheduled Operations (Audit and Log Management only)
– Retrieve Internal Code -> Retrieve code changes from FTP site to the selected objects
– Change Console Internal Code -> Retrieve Internal Code Changes ->Retrieve code changes 

from FTP site to the HMC
– Advanced Facilities->Card Specific Advanced Facilities->Manual Configuration Options-

>Import/Export source file by FTP   (For OSA-ICC PCHIDS only – Channel Type=OSC)
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HMC/SE Secure FTP support (cont.)
� New Manage SSH Keys console action
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HMC Secure FTP support (cont.)

� Export IOCDS Panel showing the new “Use secure FTP” checkbox
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HMC Secure FTP support (cont.)

� Export IOCDS Panel showing message display if the new “Use secure FTP”
checkbox is selected but no SSH keys exist for the specified address.
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Disruptive Action Confirmation Enhancement – 2.11.1

� The Operating System Name was added to the Disruptive Action Confirmation 
panel.

� Optionally, the Disruptive Action Confirmation panel requires additional text 
input before a disruptive action is allowed.

► The required text is either the OS Name or System Name

► This option is controlled via the User Profiles task on an individual user ID basis. 
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Disruptive Action Confirmation Enhancement (cont.)
� OS Name column was added
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Disruptive Action Confirmation Enhancement (cont.)
� Confirmation Text Required  - this is optional
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Disruptive Action Confirmation Enhancement (cont.)
� User Profiles – use new checkbox to require text inp ut before disruptive 

action 
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Load (IPL) for Alternate Subchannel Set – 2.11.1

� Today Load (IPL) devices must be in subchannel set 0 – this restriction is being 
removed.

� The ability to Load (IPL) from an alternate subchannel set is now supported.

� Enables customers to utilize the additional device addressability we have 
provided with less complexity involved.

� The Load Address value was expanded to 5 hex digits – the highorder (left most 
digit) represents the subchannel set and is restricted to 0, 1 or 2.

► If 4 digit address used, subchannel set is defaulted to 0.

� Impacted tasks included: Load, Customize/Delete Activation Profiles (Image and 
Load profiles), and HMC APIs (SNMP and CIM).
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Load (IPL) for Alternate Subchannel Set (cont.)
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View PMV Records – 2.11.1

� The new View PMV Records task is used to obtain Problem Management 
Viewable (PMV) records issued to the IBM Service Support System (Retain) for 
the Hardware Management Console or selected servers (CPCs). 

� These problems are typically sent to the IBM Service Support System where 
errors are not recorded by the console. A PMV record is initially created from 
the Report a Problem task via a new option.

� The customer is able to view and edit the PMV records on the console and have 
the ability for an interactive dialog with an IBM service representative
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View PMV Records (cont.)
� New option on Report a Problem task 
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View PMV Records (cont.)

� Retrieval of records from the IBM Service Support System
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View PMV Records (cont.)
� Detailed view of one record
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2048 bit Network Certificates – 2.11.1
� HMC 2.11.0 and prior use 1024 bit network certificates.

� HMC 2.11.1 will use 2048 bit certificates when

► new certificates are Created

► and then Applied

► Otherwise, existing certificates carried forward on upgrade to 2.11.1 remain at 1024 bit.

1

2
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Application Enhancements 
� New Task Group

► A new task group (“Monitor”) was created to hold “monitoring” related tasks.  Some 
existing tasks (like Customize Activity Profiles) have been moved to this group plus 
new tasks are being added. Added to both HMC and SE.

NEW TASK
GROUP
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Application Enhancements

� Environmental Efficiency Statistics Task

► Part of a new “Monitor” task group

► Today the Active Energy Manager (AEM) plugin for the IBM Director includes the ability 
to show historical power consumption and thermal information.  Customers have 
requested similar capability on the HMC.  This task will provide similar data along with a 
historical summary of processor and channel utilization.  

► The data will be presented in table form, graphical (“histogram”) form.

● Durations of one to seven days

● The data can also be exported to a Comma Separated Value (CSV) file so that it can 
be imported into customer tools like Excel or Lotus 1-2-3.

► The New Task is only usable with z196 and newer CPCs

► Data is kept on the SE and should be large enough to store at least one to two years 
worth of data.

► The maximum time period that can be shown at one time is one week; however the 
user can go forward and backward
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Application Enhancements
� Environmental Efficiency Statistics Task – Main Pane l  
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Application Enhancements
� Environmental Efficiency Statistics Task

►Data can be exported to a file - only available when a user is connected to 
the HMC remotely via a web browser.



IBM Systems
SHARE Session 9686Page 25

IBM System z Hardware Management Console (HMC) 2.11.0 

© 2011 IBM Corporation

Application Enhancements 
� Environmental Efficiency Statistics Task

►Resulting CSV file
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Application Enhancements

� SAD (System Activity Display) Re-Engineering

► In HMC 2.11.0, a new “Monitors Dashboard” task was added to the Monitor task group. 

● It provides a tree-based view of resources in the IBM System z

● Allows a user to view aggregated activity when looking at large configurations

● Also allows for more detail for objects with smaller scope 
● Supports new graphical ways of displaying data such as history charts 

► Pre HMC 2.11.0 ‘Classic SAD’ accessible via ‘Open Activity’ selection on “Monitors 
Dashboard” panel. 
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Application Enhancements
� SAD Re-Engineering
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Application Enhancements
� SAD Re-Engineering
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Application Enhancements
� SAD Re-Engineering - Histogram

The data available to display is:

� Processor utilization (%)

� Channel utilization (%),

� Power consumption (watts/BTUs),

� Input Air Temperature (C/F).

You can display the data in the 
following increments:

� 15 second increments for 1 hour

� 1 minute increments for 4 hours

� 5 minute increments for 12 hours

� 10 minute increments for 1 day

� 15 minute increments for 2 days

� 1 hour increments for 10 days
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App. Enhancements: Security Event Notification

� Email notification of security events

► Monitor System Events task now supports creating ne w event 
monitors for security logs

► Any number of users can get an email when a matchin g security log 
occurs
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App. Enhancements: Security Event Notification
� Configuring a security event monitor
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App. Enhancements: Audit reporting capabilities

� Provide scheduled and manual methods to obtain audi t reports 
which include:

► All user related data (user ids, user settings, rol es, password rules, 
LDAP servers, automatic logon, etc.)

► Configuration details (remote access, automation pa rameters, data 
replication, network settings, etc.)

► Operational data (custom group definitions, associa ted activation 
profile settings, managed resources)

► SSL certificate information

� The offloading can be manually initiated via the ne w Audit & 
Log Management task or scheduled via the Scheduled 
Operations task.
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App. Enhancements: Audit reporting capabilities

� Provide scheduled and manual methods to obtain audi t reports

� Auditable types of information broken in to 3 categ ories

Default user settings
LDAP server definitions
Password profiles
User roles
Users
User templates
User patterns

Console events
Security log
Audit log
Service history
Tasks performed log

API settings
Certificate management
Console services
Data replication
Defined CPCs
Domain security
Grouping
Monitor system events
Object locking
Product engineering access
Welcome text

User ProfilesLogsConfiguration
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App. Enhancements: Manual Audit Report Generation

Human consumable (HTML) 
and program consumable 
(XML) formats available

Entire categories or 
individual types of data 

can be selected for 
inclusion
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App. Enhancements: 
Example Audit Report

Report contains the up to 
date configuration data for 
the selected types of data

Report can be saved 
remotely using the normal 

browser “Save as…” or 
locally to removable media
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App. Enhancements: Offloading of security and event  logs

� Provide scheduled and manual methods to offload whi ch 
include:

► Security related events (log on/off, configuration changes, 
disruptive actions, etc.)

► System events (scheduled operations definition, tim e sync, 
retrieval of Licensed Internal Code (firmware) fixe s, etc.)

► Recent task history including task, targets and use r

► Service history log

� The offloading can be manually initiated via the ne w Audit & 
Log Management task or scheduled via the Scheduled 
Operations task.

� The existing Format Security Logs to DVD-RAM task i s 
redundant with these enhancements and was removed f rom the 
HMC.
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App. Enhancements: Manual Audit Report Generation ( logs)

Event based data 
can be limited to 
a specific time 

period
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App. Enhancements: Log Data Display/Save
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App. Enhancements: Scheduled generation of reports

New scheduled 
operation for 

generating audit 
reports
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App. Enhancements: Scheduled Audit Report Generatio n

Scheduled Event based 
data limiting uses days 

rather than a time period

Generated report is 
offloaded via FTP
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Application Enhancements

� Change LPAR Controls – Export to CSV File

► The Change LPAR Controls task added the ability to export the Change LPAR Controls 
table data to a CSV (Comma Separated Value) file which can be used for spreadsheet 
programs like Excel. 

► This support adds a new menu item to the panel and is only available when a user is 
connected to the HMC remotely via a web browser.
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Application Enhancements
� Change LPAR Controls – Export to CSV File

NEW EXPORT PUSHBUTTON
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Application Enhancements

� Change LPAR Controls – Export to CSV File

► Ability to export all or some of the data
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Application Enhancements

� Change LPAR Controls Scheduled Operation 

► The following enhancements were made to the existing Change LPAR Controls 
scheduled operation support:

● Allow the partition capping value to be specified
● Allow viewing of Details about an existing Change LPAR Controls schedule operation 

on HMC.
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Application Enhancements
� Change LPAR Controls Scheduled Operation 

ABILITY TO MODIFY
CAPPING
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Application Enhancements

� ETR Function Removal, Pulse per Second Diagnostic S upport, Thresholds

► z196 relies solely on STP for time synchronization. It contains two FSP/STP cards 
which do not have a fiber optic connector to attach to a Sysplex Timer, but continue to 
provide support of a Pulse per Second (PPS) port.

► System (Sysplex) Time task for a z196 target:

● Only displays if STP is enabled

● No ETR Configuration and ETR Status tabs
● Allows an ETR ID to be entered on the STP Configuration tab to support participation 

in a Mixed CTN (Coordinated Timing Network)

● Add NTP Thresholds capability
– Suppresses Hardware Messages for

♦ Stratum Level changes (due to polling NTP server)

♦ Source ID missing for a limited time (ie., GPS source blocked on a regular basis 
due to known reason)
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Application Enhancements

� ETR Function Removal, NTP Thresholds

NEW NTP THRESHOLDS PUSHBUTTON

ETR TABS REMOVED
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Application Enhancements: User Templates and Patter ns

� User template
► Defines all the same characteristics that would normally be defined for a 

user
► Restricted to LDAP authentication

� User pattern
► Defines the pattern to be used to try and match “unknown” user ids with a 

template
► Defines a default template to be used for matching user ids
► Defines the retention time (in days) for modified user setting information
► Optionally defines LDAP attributes used to determine:
● User template to be used
● “Domains” where the pattern is valid

� Note: LDAP server used for authentication can be di fferent from the 
one used to specify the template and domain names
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App. Enhancements: User Templates task

Selected the template to 
be modified, removed, 

etc.

Drop down menu to 
choose the action to be 

performed
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App. Enhancements: User Templates

Restricted to LDAP 
authentication; no 
password defined

Defines which roles a 
dynamic user based on 
this template will have

Additional user properties 
for user template is the 
same as for real users
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App. Enhancements: User Patterns task

Selected the pattern to 
be modified, removed, 

etc.

Drop down menu to 
choose the action to be 

performed
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App. Enhancements: User Patterns

Patterns allow for 2 different 
types of expressions

Default template to use if 
template not specified via 

LDAP

Number of days user 
settings data for dynamic 

users is retained

Optional LDAP attributes 
used to determine template 

and valid domains
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User Interface
� User Interface Enhancements

► Miscellaneous User Interface enhancements were made in HMC 2.11.0:

● Tree Style User Interface Enhancements
– Ability to right-mouse click on object name field to launch context menus

● What’s New Wizard
– A simple wizard which describes new features available on the HMC for each 

release

● Internet Explorer 8.0
– Support for displaying the HMC on a remote console using the IE 8.0 browser
– The following is the complete list of supported browsers
♦ IE 6.0 or later
♦ IE 7.0 or later
♦ IE 8.0
♦ IE 9.0 (2.11.1)
♦ Firefox 3.5
♦ Firefox 3.6
♦ Firefox 4.0 (2.11.1)
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User Interface

� User Interface Enhancements
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User Interface
� User Interface Enhancements – What’s New Wizard

NEW TASK
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User Interface

� Classic UI and User Settings Task Improvements

► The User Settings and Console Default User Settings console actions were both 
updated with a new ‘Classic Style’ tab. This new tab allows users to change the look of 
the Classic UI. 

► There are three choices for laying out the tasks in the Console Actions View:

● Classic : Display the console tasks and task groups just like they currently display. 
This is the default.

● List : Display all the console tasks in a flat list. 

● Groups : The Console Actions View displays groups and a couple of tasks such as 
Logoff, Shutdown and Users and Tasks. All the console tasks are contained in one or 
more console task groups. The new console groups are:
– Security

– Configuration

– Management
– Configuration

– Logs

– Internal Code

– Debug (PEMODE only)
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User Interface

� Classic UI and User Settings Task Improvements

► The user is able to hide one or more of the three panes in the Classic UI. (Task, Views, 
Task and Work)

► The context menu in the Classic UI has changed:

● All the choices in the Classic Style User Settings tab were added.
● When viewing the Console Actions in Groups view the context menu contains a new 

selection for navigating up the tree.
● Right clicking on a console task group, when viewing the Console Actions in Groups 

view, causes all the child tasks and task groups to display as does Open to open the 
selected group.

► When a user resizes one of the panes by dragging the horizontal or vertical separators 
then new sizes of the panels are persisted. When that user logs back on the pane sizes 
are restored.
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User Interface

� Classic UI and User Settings Task Improvements
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User Interface

� Flexible Controls per User on SE 

► In z10 the Customize User Controls task is available on the HMC and is used to define 
and customize user roles. 

► In z196 the Customize User Controls task was made available on the SE. 
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User Interface

� Flexible Controls per User on SE 

CUSTOMIZE USER CONTROLS

NOW AVAILABLE ON THE SE
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User Interface

� View Only User IDs/Access for HMC/SE

► The HMC and SE User ID support added the ability to create users who have View 
Only access to select tasks.

► The new View Only tasks are simply the existing tasks with minor modifications to their 
GUI controls which prevent any actions from being taken. The following subset is the 
first to support a View Only user ID. 

● Hardware Messages

● Operating System Messages

● Customize/Delete Activation Profiles

● Advanced Facilities
● Configure On/Off

► To support View Only user IDs:

● When adding tasks into a new Task Role the option of adding the View Only version 
of  that task is provided.

● The Access Administrator can then specify these Task Roles to create View Only 
user IDs if desired.
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User Interface

� View Only User IDs/Access for HMC/SE

VIEW ONLY VERSION OF 

HARDWARE MESSAGES

WAS ADDED TO THIS NEW TASK ROLE

CLICK-YES
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User Interface

� Additional Control over Toggle Lock and Details Tas ks

► In z10, all Task Roles contain the Toggle Lock task and the Details tasks for the various 
managed objects.

● They are not part of a Task Group.
● They are not shown in the GUI for the Task Role customization.

● These tasks get copied/added under the covers to any Task Roles that are created. 

► In HMC 2.11.0, the GUI shows these tasks (Toggle Lock and Details) which gives the 
administrator the ability to create Task Roles that do not have them, thus providing a 
way for the Toggle Lock and Details task to be removed for certain users.  
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User Interface
� Additional Control over Toggle Lock and Details Tas ks

TOGGLE LOCK AND DETAILS

APPEAR IN AVAILABLE TASK LIST
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Configuration and Service

� Third Subchannel Set

► A new subchannel set of 64K-1 devices was added to the existing two subchannel sets.

► The following SE tasks contain panels which contains a subchannel set value and now 
supports values of 0, 1 and 2:

● The Input/Output (I/O) Configuration task 
– View -> Dynamic Information 

– View -> Channel Path Configuration -> Device Information 

● The Channel Problem Determination task 
– Analyze subchannel data

– Analyze control unit header

– Paths to a device

● The Channel Problem Determination task 
– Analyze serial link status (FCP Channel only)

– Fabric login status

● The NPIV Configuration task 
– Display all NPIV port names that are currently assigned to FCP subchannels.
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Configuration and Service

� Increased Number of Processors
► In z196 2817, the physical number of processors was increased.

► The LPAR mode limits have also changed. The corresponding HMC/SE
panels were updated to support these new limits.

8064Logical Processors per 
LPAR

8064Total Physical LICCC 
Processors per System 
(CPs, zIIPs, zAAPs, IFLs, 
ICFs, not SAPs)

9680Physical PUs

Z196 2817Z10 2097
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Configuration and Service
� Broadband RSF/Media Only Firmware Component Updates

►Firmware Updates on System z can be obtained via

● RSF (Remote Support Facility) IBM Support Center us ing a 
– Broadband connection or a 
– Modem connection

●Media

►Firmware for zBX components has a tendency to be much larger than current System z 
FW

►z196 will limit some FW components such they can only be updated via Broadband RSF 
or Media, not Modem RSF

● Even in some of those cases, if the size of the FW update is too large, it may 
be decided to not even put fixes into RSF (RETAIN) and would only be 
available via media.

►Service team has been working with customers to migrate to Broadband RSF

● Security concerns of using Broadband versus modem h ave been addressed.
● Available from IBM Resource Link: Library->z196>Technical Notes

– System z Hardware Management Console Broadband Remo te Support 
Facility
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Miscellaneous 

� Allow setting Acceptable Status for Multiple Object s

► In z10, setting up acceptable status on a new install requires the user to set the status 
one object at a time.

► In HMC 2.11.0, a new field, “Save as default”, was added to each Acceptable Status 
tab which allows the user to change the acceptable status for all of the currently defined 
objects of that type. 

► This change will be applied to all object types that currently provide the ability to monitor 
their status.

► A warning message is issued before the acceptable status data is actually changed.



IBM Systems
SHARE Session 9686Page 69

IBM System z Hardware Management Console (HMC) 2.11.0 

© 2011 IBM Corporation

Miscellaneous 

� Allow setting Acceptable Status for Multiple Object s

New Checkbox
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Miscellaneous 

� New Removable Writeable Media to Replace HMC DVD-RA M

► A new removable writeable media is being introduced in HMC 2.11.0 as an alternate to the HMC 
DVD-RAM. 

● Qualified DVD-RAM media has gone End Of Life.
● The new media selected is the USB Flash Memory Drive (UFD).

► Initially, the HMC 2.11.0 will ship with both a DVD-RAM drive as well as a UFD, but over time the 
DVD-RAM drive will be phased out. 

► All tasks on a HMC 2.11.0 as well as any SEs that can be managed by a HMC 2.11.0

● previously supported the DVD-RAM/migrated to now support the UFD

► The UFD is the first media device for which there can be more than one present in the console

● This is due to the fact that the Backup task requires a UFD in the console.
● Non-Backup tasks that access a UFD are now aware that more than one UFD can be present in 

the console and ensure the correct one is accessed.
● When Multiple UFDs are plugged,

– One should be the Backup UFD
– All nonBackup Critical Data tasks (except Format Media) will ignore the Backup UFD. 
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Miscellaneous 

� Power Saving Mode
► The power saving feature is built upon an existing mechanism for cycle and voltage 

steering. This mode reduces processor cycle time for all System z processors in the 
system.   Memory and IO cycle times are not affected.

► In z196 the following support was added:

● HMC/SE User Interface to enable/disable power saving mode (i.e. new Set Power 
Saving task)

● Indication on HMC/SE if power saving mode is active.
● SE-based scheduled operation to enable/disable power saving mode

● Reset Profile and Power-on-Reset updates to allow Power Saving mode to be 
specified.
– The two options are:

♦ Custom Energy Management - use values specified on the new Set Power 
Saving task 

♦ Emergency High Performance – all objects are placed into High Performance 
model
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Miscellaneous 
� Power Saving Mode

� For zCPC, limit of one 
transition to Low Power 
per day

� Low to High

� High to Low 

� High to Low to High

� Low to High to Low

� Reason

� Based on hardware 
RAS limits

� Similar concept of 
limits on flash 
memory writes
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Miscellaneous 
� Power Saving Mode

POWER SAVING 

MODE OPTIONS
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Thank you for your time and consideration….

Brian Valentine

HMC/SE Team

Contact for any Questions:

� Brian Valentine, (607) 429-4382, bdvalent@us.ibm.com
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Additional Miscellaneous HMC 2.11.0 Enhancements

� CFCC Diagnostics Page:  76 – 78

� 3-D Repair and Verify Page:  79 – 82

� Service User Task for RSF Diagnostics Page:  83 – 84

� Power on Reset Support of Auto I/O Interface Reset P age:  85 – 86

� Consistent Sorting for Operating System Messages Pag e:  87 – 88

� Controlling Group Capacity with HMC SNMP API Page:  89

� Image Activation Profile Validation Override Page:  90 – 93

� Remove Support for Dynamic ICF Expansion Option Page :  94

� Remove Support for Crypto Express2 Page:  95 – 96



IBM Systems
SHARE Session 9686Page 76

IBM System z Hardware Management Console (HMC) 2.11.0 

© 2011 IBM Corporation

Application Enhancements

� CFCC Diagnostics

► Improvements were made to first-failure-data-capture support for diagnosing Coupling 
Facility Control Code related problems

► A maximum of 10 new CFCC Diagnostic dumps will be stored on the SE. Each dump is 
expected to be 128 MB.

● CFCC Diagnostic dumps are internally triggered based on detection of an error 
situation.

● CF Dumps (max of 2) are triggered manually the Dump LPAR Data task.

► The Delete LPAR Dump Data task was updated to display and allow manual deletion of 
the new CFCC Diagnostic dumps.

► The Transmit Service Data task was enhanced to process the new CFCC Diagnostic 
dumps. A new panel selection was added in order to differentiate the new CFCC 
Diagnostic dumps from the existing CF dump.
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Application Enhancements
� CFCC Diagnostics

NEW CF DIAGNOSTIC

DUMP TYPE



IBM Systems
SHARE Session 9686Page 78

IBM System z Hardware Management Console (HMC) 2.11.0 

© 2011 IBM Corporation

Application Enhancements
� CFCC Diagnostics

NEW SELECTION FOR ADDITIONAL 
CFCC DUMP DATA
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Configuration and Service

� 3-D Repair and Verify

► This change replaced the static location graphics currently used by the Repair/Verify 
task for FRU location with an interactive 3-Dimensional viewer. 

► It uses the actual system configuration to build the model for a more accurate 
representation of the system for the SSR (CE). 

► It is possible to rotate and zoom the model, and to show the location of the FRU that 
will be replaced.

► In addition it also shows the locations of new parts that are going to be added.
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Configuration and Service

� 3-D Repair and Verify
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Configuration and Service

� 3-D Repair and Verify
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Configuration and Service
� 3-D Repair and Verify
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Configuration and Service

� Service User Task for RSF Diagnostics

► A new scheduled operation "Perform RSF Diagnostic Requests" was made available to 
IBM Service and Product Engineers on the HMC. 

► This task provides the ability to stress the transmission of data to and from IBM support 
(without storing data in RETAIN) and optionally create tcpdump traces for use by the 
PE team. 

► The following panel shows the options available when creating the new scheduled 
operation.
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Configuration and Service

� PE/CE Task for RSF Diagnostics
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Miscellaneous 

� Power on Reset Support of Automatic I/O Interface R eset

► Consistency was improved between the Power on Reset panel and Reset profile. 

● In z10, the Automatic I/O Interface Reset option is available on the Options tab of the 
Reset profile but is not available on the Options tab of the Power on Reset panel.

● In z196, the Power on Reset task was updated to include the Automatic I/O Interface 
Reset option on the Options tab.
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Miscellaneous 

� Power on Reset Support of Automatic I/O Interface R eset

AUTOMATIC I/O INTERFACE

RESET NOW AVAILABLE
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Miscellaneous 

� Consistent Sorting for Operating System Messages

► In the pre z9 HMC/SE, the Operating System Messages Task arranged the CPC:LPAR 
name tabs in ascending alphabetical order.

► In the z9 and z10 HMC/SE, this fixed sort order was lost, and the tabs were arranged in 
a random order. 

► In HMC 2.11.0, the ascending alphabetical order sort order in the Operating System 
Messages Task was restored.
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Miscellaneous 
� Consistent Sorting for Operating System Messages

CONSISTENT

SORTING
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Miscellaneous 

� Controlling Group Capacity with HMC SNMP API

► The Change LPAR Group Controls task provides the ability to modify the group 
members and group capacity setting. These updates can be applied dynamically to the 
running system or saved to the Group and corresponding Image profiles.

► In z10, the SNMP API provides support for updating the Group Profile capacity value 
but does not allow the group capacity setting to be applied dynamically to the running 
system.

► In HMC 2.11.0, the SNMP and CIM APIs are enhanced to allow dynamic changes to 
both the group members and group capacity setting.
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Miscellaneous 

� Image Activation Profile Validation Override
► Background

● Image profiles validated to conform to maximums of LICCC Permanent and 
Temporary (On/Off CoD, CBU, CPE)
– Image Mode (ESA/390, CF, LINUX only, etc.)
– Initial Processor values (including types)
– Initial storage

● Validation occurs 
– at Image Activation Profile save
– Automatically internally and profile migration will occur for
♦ Import Profiles
♦ LICCC Update
♦ Temporary Record Deletion

- Replenishing records avoids this profile migration situation
♦ New GA code release is applied

- GA1 to GA2
- MES Upgrade to new Machine Family (ie., z10 to z196)
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Miscellaneous 

� Image Activation Profile Validation Override
► New Image Profile control that allows override of validation on Save or Migration 

conditions

● Default/Recommended Setting: Validate (checkbox control checked)
● Careful considerations to turn off validation

– Preparing Image Profiles prior to LICCC records installed
♦ Should check and validate profile once LICCC record updates on complete

– Loaner engines were given in form of permanent capacity and want to maintain 
Image profile for future sandbox like control
♦ Again, should consider validation when ready to use again

► New Hardware Message that Profiles were internally updated

► Detailed explanation of Profile validation and update rules can be found at IBM 
Resource Link in Publication “Tech Notes” section

● IBM Resource Link: Library->z196>Technical Notes
– System z Activation Profile Update and Processor Rules
♦ Will be updated to include this new validation override control
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Miscellaneous 

� Image Activation Profile Validation Override
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Miscellaneous 

� Image Activation Profile Validation Override
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Miscellaneous 

� Remove Support for Dynamic ICF Expansion Option

► The Activation Profile support will be updated to remove support for Dynamic ICF 
expansion both across ICFs and across pool of shared CPs.

► This update will affect the Processors page of a Coupling facility mode Image Profile. 
The Logical Processor Assignment section of the Processor page will remove the 
following selections:

● Dedicated and not dedicated internal coupling facility processors

● Dedicated internal coupling facility processors and not dedicated central processors
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Miscellaneous 

� Remove Support for Dynamic ICF Expansion Options

DYNAMIC ICF EXPANSION

OPTIONS REMOVED
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Miscellaneous 

� Remove Support for Crypto Express2

► z10 EC GA3 supported Crypto Express2 and Crypto Express3.

► z196 is only supporting Crypto Express3. 

► All references to Crypto Express2 were removed from the SE panels and 
documentation. The affected tasks include: 

● Cryptographic Configuration
● Cryptographic Management

● View Lpar Cryptographic Controls

● View Licenses - This involves removal of the selection "PCIXCC and CEX2C 
Readme file"
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Additional Materials

� Other SHARE Sessions of Related Interest

� Registering for IBM Resource Link Access

� Notable HMC/SE Publications



IBM Systems
SHARE Session 9686Page 98

IBM System z Hardware Management Console (HMC) 2.11.0 

© 2011 IBM Corporation

Other SHARE Sessions of Related Interest

► August 10th, 8:00 – 9:00 AM

● 9738: IBM zBX HMC Hardware and Operational Management

► August 10th, 9:30 – 10:30 AM

● 9738: zEnterprise Unified Resource Manager 

► August 10th, 11:00 AM – 12:15 PM

● 9709: zManager: Platform Performance Management

► August 10th, 3:00 – 4:00 PM

● 9635: zEnterprise Unified Resource Manager: What's in it for z/VM?

► August 11th, 8:00 – 9:00 AM

● 9711: Unified Resource Manager Hands-On Lab - Part 1 of 2

► August 11th, 9:30 – 10:30 AM

● 9818: Unified Resource Manager Hands-On Lab - Part 2 of 2
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Registering for IBM Resource Link Access

� To view the documents on the Resource Link Web site . you need to
register your IBM Registration ID (IBM ID) and pass word with Resource 
Link.

� To register:
► Open the Resource Link sign-in page: http://www.ibm.com/servers/resourcelink/

► You need an IBM ID to get access to Resource Link.

● If you do not have an IBM ID and password, select t he "Register for an IBM 
ID" link in the "Your IBM Registration" menu. Retur n to the Resource Link 
sign-in page after you get your IBM ID and password .

● Note: If you’re an IBM employee, your IBM intranet ID is not an IBM ID.

► Sign in with your IBM ID and password. 

► Follow the instructions on the subsequent page.
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Reference Documentation
� Available from “Books” group of Classic Style UI and the Welcome page of the 

Tree Style UI (& IBM Resource Link: Library->z196->Publications)

► IBM SC28-6895: Hardware Management Console Operatio ns Guide ( Version 
2.11.0)

● IBM SC28-6905: (Version 2.11.1)
► IBM SC28-6896: Support Element Operations Guide (Version 2.11.0)

● IBM SC28-6906: (Version 2.11.1)
► IBM SB10-7030: Application Programming Interfaces

► IBM SC28-2605: Capacity on Demand User’s Guide

► IBM SB10-7154: Common Information Model (CIM) Manag ement Interfaces

► IBM SB10-7155: PR/SM Planning Guide

► IBM SA22-1086: System Overview (z196)

► IBM SA22-1087: System Overview (z114)

� Available from IBM Resource Link: Library->z196->Technical Notes
► System z Hardware Management Console Security

► System z Hardware Management Console Broadband Remo te Support Facility

► System z Activation Profile Update and Processor Ru les
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